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Notations Used in This Guide

The following table shows the symbols used in this manual, along with descriptions of what they mean.

Attention Indicates procedures which may result in damage or injury if sufficient care is not taken.
== Indicates additional information and points which may be useful to know regarding a topic.
/@\

- Indicates a page where detailed information regarding a topic can be found.

Procedure Indicates operating methods and the order of operations.

The procedure indicated should be carried out in the order of the numbered steps.

[ (Name) ] Indicates the name of the buttons on the projector's remote control or the control panel.

Example: [Esc] button

"(Name)" Indicates the name of the buttons on the EasyMP Monitor or OS screens.
Timer (Boldface) Example:

Select "Timer" - "Timer Settings".
Select Timer - Timer Settings.
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EasyMP Monitor Features



Tasks that can be done using EasyMP Monitor

EasyMP Monitor lets you carry out operations such as checking the statuses
of multiple EPSON projectors that are connected to a network at a
computer monitor, and controlling the projectors from the computer.

Following are brief descriptions of the monitoring and control functions
that can be carried out using EasyMP Monitor.

¢ Registering projectors for monitoring and control
Projectors on the network can be searched for automatically, and you can
then select projectors to be registered from the projectors that are
detected.
You can enter the IP addresses for target projectors to register them.

¢ Registered projectors can also be assigned to groups so that they can
be monitored and controlled in groups.

e Monitoring the statuses of registered projectors
The power status (ON/OFF) for projectors and problems or warnings
requiring attention can be checked visually by means of icons.
You can select groups of projectors or a single projector that you are
interested in, and then check the cumulative lamp operating time or the
details of information such as input sources, problems, and warnings for
these projectors.

¢ Controlling registered projectors
Projectors can be selected in groups or as single projectors, and you can
then carry out operations for the selected projectors such as turning the
power on and off and switching their input sources.
Web control functions can be used to change the settings in the
projector's configuration menu.
If there are certain control actions which are carried out regularly at
particular times or on particular days, you can use Timer Settings to
register timer settings.

e Mail notification function settings
You can set e-mail addresses to which notifications are sent if a status
requiring attention, such as a problem, occurs with a projector that has
been registered.

¢ Sending messages to registered projectors

You can send JPEG files to the registered projectors at once by using
Message Broadcasting, which is a plug-in software for EasyMP Monitor.
The software and manual can be downloaded from the website below.
http://www.epson.com/
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Installing EasyMP Monitor

Operating environment

This software is compatible with computers that comply with the following
requirements.

oS Windows 2000 Professional SP4
Windows XP Home Edition SP2/SP3*
Windows XP Professional SP2/SP3*

Windows Vista”
(All editions except Starter Edition)

Windows Vista SP1/SP2*
(All editions except Starter Edition)

Windows 7 32 bit version
(All editions except Starter Edition)

Windows 7 64 bit version
Windows 8 32 bit version
Windows 8 64 bit version
e Internet Explorer Ver. 5.0 or later must be installed.

CPU Pentium MMX 166 MHz or higher (Pentium II 233 MHz
or higher recommended)

Memory capacity | 64 MB or more (128 MB or more recommended)

Free hard disk
space

Display SVGA (800 x 600) or higher resolution, 32 bit or higher
display colour

50 MB or more

*  Supports only 32 bit version of OS.

e Macintosh computers cannot be used.

e Operations carried out at the computer may become slow depending on
the number of projectors being managed. If this happens, use a
computer with higher specifications.

e EasyMP Monitor cannot be used in environments which do not allow
pings to be transmitted.

Transferring the settings

If you are already using EasyMP or EMP Monitor, you can transfer the
projector settings to this version. The settings are stored as a data file (EMP
Monitor.dat). Make a copy of the EMP Monitor.dat before you install this
software. EMP Monitor.dat can be found at the following location if the
default settings were used to install the software:

e If your operating system is Windows 2000 or Windows XP
"C:\Program Files\EPSON Projector\EasyMP (or EMP) Monitor Ver.
XXX (Ver. X.XX represents the software version)"

e If your operating system is Windows Vista or Windows 7

"C:\Users\(User Name)\AppData\Local\VirtualStore\Program Files\EPSON
Projector\EasyMP (or EMP) Monitor Ver. X.XX (Ver. X.XX represents
the software version)"
If you cannot find the "AppData" folder, click "Start" - "Control Panel" -
"Appearance and Personalization" - "Folder Options". Select the "View"
tab, and then configure the "Show hidden files, folders, and drives" setting
in "Advanced settings".

e If your operating system is Windows 8
"C:\Users\(User Name)\AppData\Local\VirtualStore\Program Files\EPSON
Projector\EasyMP (or EMP) Monitor Ver. X.XX (Ver. X.XX represents
the software version)"
If you cannot find the "AppData" folder, select "Charms" - "Search"-
"Control Panel" - "Appearance and Personalization" - "Folder Options".
Select the "View" tab, and then configure the "Show hidden files, folders,
and drives" setting in "Advanced settings".

After installing this software, follow the instructions below before starting
EasyMP Monitor to transfer the settings.

e If your operating system is Windows 2000 or Windows XP
Overwrite the existing EMP Monitor.dat file with the copy you made. The
existing EMP Monitor.dat file is in "C:\Program Files\EPSON Projector
\EasyMP Monitor Ver.X.XX".
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o If your operating system is Windows Vista, Windows 7, or Windows e You must have administrator authority in order to use Register at
8 startup on the Environment setup screen of EasyMP Monitor.
Place the copy of the EMP Monitor.dat file in "C:\Users\(User Name) @ "Monitoring using the system tray" p.24
\AppData\Local\VirtualStore\Program Files\EPSON Projector\EasyMP o If EasyMP Monitor is installed on your computer, uninstall it before
Monitor Ver.X.XX". you update the operating system to Windows Vista, Windows 7, or
Windows 8. Updating your OS without uninstalling the software may
\@__ The software name has been changed. cause a malfunction. @ "Uninstalling EasyMP Monitor" p.40

Before: EMP Monitor — After: EasyMP Monitor

If you are already using EMP Monitor, you can replace with this . .
software. Before starting operations

Check the following points before starting up EasyMP Monitor.

e EasyMP Monitor must be installed on the computer to be used for
Installing monitoring and control.

e The computer and the projectors must be connected to the network.
¢ Depending on the projector model, a commercially-available serial «»
Download the latest version of EasyMP Monitor from the website below. TCP/IP conversion adapter and a connection cable are required in order
to use EasyMP Monitor. @ Projector's User's Guide "Standby Mode"
Make the settings for the serial «» TCP/IP conversion adapter before
connecting to the projector.

You must have administrator authority in order to install EasyMP Monitor.

http://www.epson.com/

Double-click the downloaded software file to start the install program.
Follow the on-screen instruction.

- To enable projectors to be monitored and controlled even when they
If EasyMP or EMP Monitor is already installed, uninstall it before installing '@‘ are in standby mode®, make the following settings at the projectors.

this software. @ "Uninstalling EasyMP Monitor" p.40 The settings that need to be made will vary depending on the

) ) ) ) ) projector you are using. @ Projector's User's Guide
When using Windows Vista: You must update to Windows Vista SP1 to

use the Ukrainian version e Set Standby Mode to Communication On (or Network On).

e Set Network Monitoring to On.

* When the projector's () indicator is lit orange.

Limitations imposed by a Windows Vista, Windows
7, or Windows 8 environment

When using EasyMP Monitor under Windows Vista, Windows 7, or
Windows 8 note the following limitations.


http://www.epson.com/
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Using EasyMP Monitor



Registering and deleting projectors for monitoring

This operation is carried out when starting EasyMP Monitor for the first )
time after it has been installed and when you would like to add projectors.

Once a projector has been registered, the status for the projector will be

displayed automatically each time EasyMP Monitor is started from that

point onwards.

The main window will be displayed.

The red box area described in the screen below is referred to as
Grouping view.

e =X

iz Edt Yew Iool Help
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The operations to register projectors vary as followings depending on where
the projectors are connected to in the network.

e When registering a projector that is located in the same segment as the
computer in which EasyMP Monitor is installed. @ "Registering
projectors using automatic search (Searching for and registering
projectors that are located in the same segment)" p.10

e When registering projectors that are in multiple segments of the
network. @ "Setting the range of addresses to do an automatic search
and registration” p.13

Starting EasyMP Monitor
Registering projectors using automatic search
(Searching for and registering projectors that are

p =
Q); Use one of the following methods to start EasyMP Monitor. located in the same segment)
e If your operating system is Windows 2000, Windows XP, Windows

Vista, or Windows 7 Procedures for automatic search

Click "Start" - "Programs"” (or "All Programs") - "EPSON Projector” -

"EasyMP Monitor Ver.X.XX" in that order to start EasyMP

Monitor.

o If your operating system is Windows 8 “ § Right-click in Grouping view and select "New" - "Projector

Select "Charms" - "Search” - "EasyMP Monitor Ver.X.XX" in that "~ (automatic search)".
order to start EasyMP Monitor. The following Create new projector (automatic registration) window
will be displayed.

If Detail list view is displayed, select New - Projector (automatic
search) from the Edit menu.



Registering and deleting projectors for monitoring

Al/s

== * You can also carry out this operation by selecting New - Projector
'@‘ (automatic search) from the Edit menu.

e Projectors that are using a serial «» TCP/IP conversion adapter
cannot be detected.

Procedures for registration

Procedure

[ Specify an address range and search, gw\"” %é
Stertaddess | | Endeddhess | \_/ Select the projector(s) to be registered from the displayed list,
Search Edit Cancel and then CliCk "Edit"o

The following window will be displayed.

N
%®§ Click "Search".

Automatic searching will be carried out, and the names of the
projectors that have been detected will be displayed.

If a projector does not appear in the list, use "Registration by
specifying an IP address (Manual registration)". @ p.15

Create new projechor (automatic registration;)

Projector name IP address
Projector10 192168040
Projectord 192168041
Projector12 192168042
Projector!3 192168043
Projector1d 192168044
Projector1s 192168045
Projector16 192168046

[ Specify an address range and search.

Start address End address

Search Edit Cancel




Dizplay name

Disclan IP address This shows the IP address for the registered projector.
isplay icon
™o @ ) Use Serial « This cannot be selected when registering projectors
TCP/IP conver- | using automatic search.
sion adaptor.
< | I P

Port Number This cannot be selected when registering projectors

o=ty | (Nane) || using automatic search.

Projectar name

Registering and deleting projectors for monitoring

| Projector]

Make the necessary settings while referring to the following table.

Projector name

This shows the name that has been registered on the
projector.

Monitor Pass-
word

If a Monitor Password has been set for the projector, be
sure to enter the Monitor Password that has been set. If

Display name

Enter the name of the projector(s) to be displayed in

IP add Search : e
St | 16 . 25¢ 163 16 —= the correct password is not entered at this time, it will not
[~ be possible to monitor and control the projector even
though it is registered.
Port Mumber
Description You can enter some kind of memo about the projector.
izt Pssamid | The details you enter here will be displayed at the
Daserintion projector properties.
Up to a maximum of 60 bytes can be entered.
v | Monitar Monitor Select this when you want monitoring to start.
BReaqister Caticel

g“‘%g
@ After entering the details, click "Register" to start the

registration. When the message is displayed, click "OK".

To continue registering other projector(s), repeat steps 1 and 2.

Grouping view or Detail list view. ~@—_ Projectors that have been registered using automatic search are
’

Up to a maximum of 32 bytes can be entered. A space g searched for again by projector name each time EasyMP Monitor is
started.

cannot be used as the first character.

Select the icon(s) to be displayed in Grouping view or
Detail list view.

Display icon

Parent group Select when registering a projector in a group.
If no groups have been created, this cannot be selected.
@ "Registering several projectors to a monitoring

group all at once" p.16
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5

4

a%@ To end the registration operation, click E in the top-right
corner of the window or click "Cancel".

The icon(s) of the projector(s) you registered will be displayed in
Grouping view or Detail list view.

Refer to @ "Monitoring window layout” p.19 for details on using
the Grouping view and Detail list view.

Setting the range of addresses to do an automatic

h . . @peufy an address range and search.
searc and regIStratlon Start address ( 192 . 168 . 0 . 00 )gdaddress ( 192 , 168 . 0 ., 50 "
>
Search Edit Cancel

:@: Projectors that are using a serial «» TCP/IP conversion adapter cannot
> ~

4

be detected.

" Click "Search".

Automatic searching will be carried out, and the names of the
projectors that have been detected will be displayed.

Procedures for automatic search

Create new o {automatic registration)

Projectar name IP address
Proce ure Frojector10 192168040
. Projectori 192168041
\- . . . . . " " " . Projectar12 192168.042
J Right-click in Grouping view and select "New" - "Projector Frojactor!3 192168043
(automatic search)“. Projector14 192.168.0.44
Frojector1s 192168045
The Create new projector (automatic registration) window will be Projestor6 192163046

displayed.

If Detail list view is displayed, select New - Projector (automatic
search) from the Edit menu.

|v Specify an address range and search.

Start address 192 . 168 . 0 . 00 End address 192 . 168 . 0O . 50

Select the "Specify an address range and search." check box :
and then enter "Start address" and "End address" in the range. Reatch

Edit Cancel
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Procedures for registration

Procedure

/ Select the projector(s) to be registered from the displayed list,

and then click "Edit".
The following window will be displayed.

Create new projector {aukomatic search)

Dizplay name

Dizplay icon

Parent group

Prajectar harme

IF address

n
Part Humber
Monitor Password

Description

[ M onitor

|[None] j

| Projector10

[ 169 . 254 . 183 . 15 Search
HReqister Cancel

Make the necessary settings while referring to the following table.

Display icon

Select the icon(s) to be displayed in Grouping view or
Detail list view.

Parent group

Select when registering a projector in a group.

If no groups have been created, this cannot be selected.
@ "Registering several projectors to a monitoring
group all at once" p.16

Projector name

This shows the name that has been registered on the
projector.

IP address

This shows the IP address for the registered projector.

Use Serial «
TCP/IP conver-
sion adaptor.

This cannot be selected when registering projectors
using automatic search.

Port Number

This cannot be selected when registering projectors
using automatic search.

Monitor Pass-
word

If a Monitor Password has been set for the projector, be
sure to enter the Monitor Password that has been set. If
the correct password is not entered at this time, it will not
be possible to monitor and control the projector even
though it is registered.

Description

You can enter some kind of memo about the projector.
The details you enter here will be displayed at the
projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor

Select this when you want monitoring to start.

Display name

Enter the name of the projector(s) to be displayed in
Grouping view or Detail list view.

Up to a maximum of 32 bytes can be entered. A space
cannot be used as the first character.

/ After entering the details, click "Register" to start the

registration. When the message is displayed, click "OK".

To continue registering other projector(s), repeat steps 1 and 2.
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) To end the registration operation, click E in the top-right

corner of the window or click "Cancel". Display name I
éhe ic.on(s). of the lg)rojic‘igr(s).you registered will be displayed in S
rouping view or Detail list view. H'—' = B
Refer to @ "Monitoring window layout” p.19 for details on using @
the Grouping view and Detail list view. ‘| | o
Barent group | [Mane] ﬂ
Registration by specifying an IP address (Manual RS e !
reg ist ration) IP address | , , , Search

[ Usze Senial <+ TCPAP coreersion adaptar.

Procedure Fart Mumber

Monitor Passwond |

®§ Right-click in Grouping view and select "New" - "Projector
(manual registration)". Digseription

The following window will be displayed.

If Detail list view is displayed, select New - Projector (manual < Honier

registration) from the Edit menu. Register Cancel

- You can also carry out this operation by selecting New - Projector
(manual registration) from the Edit menu.

Enter the IP address of the projector to be registered in the "IP
address" box and then click "Search". When the message is
displayed, click "OK".

If using a serial «» TCP/IP conversion adapter and cable to connect
the projector, select Use Serial «» TCP/IP conversion adaptor, enter
the port number in Port Number, and then click Search.
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After searching is complete, enter the information for the

projector to be registered while referring to the table below.

Display name

Enter the name of the projector(s) to be displayed in
Grouping view or Detail list view. Up to a maximum of 32
bytes can be entered. A space cannot be used as the first
character.

After entering the details, click "Register" to start the
registration. When the message is displayed, click "OK".

The icon(s) of the projector(s) you registered will be displayed in
Grouping view or Detail list view.

Display icon

Select the icon(s) to be displayed in Grouping view or
Detail list view.

Parent group

Select when registering a projector in a group. If no
groups have been created, this cannot be selected.

@ "Registering several projectors to a monitoring group
all at once" p.16

Projector name

This shows the name that has been registered on the
projector.

IP address

This shows the IP address that you entered in step 2.

Use Serial «
TCP/IP conver-
sion adaptor.

Select this if using a serial «» TCP/IP conversion adapter
to connect the projector.

Port Number

If using a serial «» TCP/IP conversion adapter to connect
the projector, enter the port number.

Monitor Pass-
word

If a Monitor Password has been set for the projector, be
sure to enter the Monitor Password that has been set. If
the correct password is not entered at this time, it will not
be possible to monitor and control the projector even
though it is registered. If using a serial «» TCP/IP
conversion adapter to connect the projector, the Monitor
Password security function cannot be used.

Description

You can enter some kind of memo about the projector.
The details you enter here will be displayed at the
projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor

Select this when you want monitoring to start.

Registering several projectors to a monitoring
group all at once

Projectors that have been registered can then be registered together into
different groups so that they can be monitored and controlled together.

Furthermore, if you select one of the registered groups as the Parent group,
monitoring and control operations can be carried out for all projectors in
that Parent group.

A Parent group can be set for other parent groups, so that a hierarchical
group arrangement can be created.

First, create the registration groups, and then register projectors into the
groups that have been created.

Procedure

’ Right-click in Grouping view and select "New" - "Group".

The following window will be displayed.
Make the necessary settings while referring to the table below.

If Detail list view is displayed, select New - Group from the Edit
menu.
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Group name | |
Display ican

K i
Barent group |[Nune] j
-

Register Cancel

Group name Enter the name of the group to be displayed in Grouping
view or Detalil list view.

Up to a maximum of 32 bytes can be entered. A space
cannot be used as the first character.

Display icon Select the icon(s) to be displayed in Grouping view.

Parent group This selects the parent group. If no groups have been
created, this cannot be selected.

Monitor Select this to monitor all projectors that have been
registered in the group. If this is not selected, the settings
made when the individual projectors were registered will
be used.

It cannot be set when creating a new group.

s—,
@ When the setup is complete, click "Register" to start the
registration. When the message is displayed, click "OK".

The icon(s) of the projector(s) you registered will be displayed in
Grouping view.

Right-click the projector icon(s) to register to the group you
have created in Grouping view or Detail list view, and select
"Edit".

N4

You can also carry out this operation by selecting Edit in the Edit
menu.

’ In the Edit projector window, select the group name to use for
registering in Parent group and then click "Change".

The status of the group registration will be displayed as an icon in
Grouping view.

A/
~ =

~r~- The registration details can also be checked using Projector list in the
’@ View menu.

\ls
~ =

~r- You can also carry out this operation by selecting New - Group from
'@‘ the Edit menu.

If the projector name or IP address changes after
registration

For projectors that have been registered manually

Procedure

g,
&
7 3

Right-click on a projector icon in Grouping view or Detail list
view and select "Monitoring disabled". Then right-click the
projector icon again and select "Edit".
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:@—_ You can also carry out these operations by using the Edit menu.
» N

/ If only the projector name has been changed, click "Search" in
" the Edit projector window that is displayed. If the IP address
has been changed, enter the new IP address in the "IP address”
box and then click "Search”". When the message is displayed,
click "OK".

”/ When the display returns to the Edit projector window, click
"Change".

For projectors that have been registered using automatic search

Procedure

Delete the projector(s) whose name or IP address has been
changed in Grouping view or Detail list view. @ p.18

Carry out automatic search to re-register the projector(s).
@ p.10

Cancelling projector registrations (Delete)

The registrations for projectors can be deleted if they are no longer required
for monitoring or control using EasyMP Monitor.

Procedure

Right-click the icon for the projector or group that is to be deleted in
Grouping view or Detail list view and select "Delete". When the
message is displayed, click "OK".

More than one projector can be selected for deleting by selecting in
Grouping view or Detail list view.

The methods of selecting more than one projector at the same time are as
follow.

e If you select a Group icon in Grouping view, all projectors that have
been registered in that group will be deleted at the same time.

e Hold down the Ctrl key on the keyboard while clicking on the desired
icons.

e Use drag and drop to select a range of desired icons.

:@—_ You can also carry out this operation by selecting Delete in the Edit
N menu.




Monitoring window layout

Types of monitoring windows and switching How to switch views

method

Grouping view and Detail list view are switched as follows.

Procedure

Click the View menu, and select "Grouping view" or "Detail list
¢ Grouping view view".
This view lets you check the status of group registrations in a
hierarchical diagram.

Types of monitoring windows

There are two types of monitoring windows. Select a desired window.

Sl oo8azaSSssaamzsaaasa Monitoring using Grouping view
g ® @ . . S
" : Meanings of Grouping view icons
9 @
"a R In Grouping view, the patterns on the icons indicate the statuses of the

projectors. If the group icons are round in shape, it indicates that there is
another level below them. @ p.20

Grouping view ] O

Eile Edt Yiew Tool Help

1 7. . cfresd i ) J ©E €8 goq e Bgea H e m s L=
e Detail list view o R 0o 28~ ) s i

This view lets you display the status of each projector as a list so that
the projectors can be checked in detail. You can also display specific
items as a list, and sort display items using a specific row as a sort
key.

"r.:;u:u&iu&;us"l'

9000000000 BO00

Detail list view

Showroam A
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The icon patterns and their meanings are explained below.

Group

No warnings or problems

All projectors in the group are normal.

__ | Warning or problem
@ A projector in the group has a warning or problem status.

Notification

A projector requiring immediate attention has been detected within the
group.

Monitoring disabled
. The projector is not being monitored. If you right-click the icon and select
Monitoring enabled, the projector will be added to the projectors that are
being monitored.

ng Data being updated

Projector

No warnings or problems”!

wa

Warning or problem

Notification

Monitoring disabled

Data being updated

Network error (Monitor Password authentication error)

g ¢« @ 0 &

No Monitor Password was entered when the projector was registered,
or an incorrect Monitor Password was entered. @ p.11, p.14, p.15

Projector

~= | Network error (TCP connection error)*2

~— | Network error (ESC/VP.net communication error)*3
L

=N

*1 When Temperature level display group view is set to On at Environment setup
in the Tool menu, an icon indicating the internal temperature of the projector
will be displayed on top of the projector icon. The default setting is Off. As
you can get an idea of how the temperature inside the projector is increasing
when Temperature level is displayed, you can make improvements to the
projector's operating environment before a high internal temperature error or
high-temperature warning occur. @ p.24

*2  Check the following items.

- Check that the projector's power is turned on.

- Check that the LAN cable is connected.

- Check that Standby Mode is set to Communication On (or Network On) or
Network Monitoring is set to On in the projector's configuration menu.

*¥3  Check that the projector has been correctly connected to the network.

- The projector information that is generated when a problem is

@ detected is stored until EasyMP Monitor is closed. EasyMP Monitor
displays will not be updated automatically even if the projector status
returns to normal. Click "Refresh" in the main window to update the
status.

Using the icons in Grouping view

The following icon operations can be carried out in Grouping view.
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e Expanding and collapsing icons
Each time you double-click a group icon, the icons for the projector
that have been registered in that group are displayed or hidden.

e Moving icons
To change the position of an icon within Grouping view, simply drag
and drop the icon to be moved.

Monitoring using Detail list view

Meanings of Detail list view icons

The status of registered projectors is displayed as a list in Detail list view
regardless of which Group the projectors belong to.
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The icon patterns and their meanings are explained below.

@ Type
Displays the projector status.
«a No warnings or problems"!

Warning or problem

%

An error has occurred on the projector.

Notification

(9

The projector requires immediate attention.

Monitoring disabled

The projector is not being monitored. If you right-click the icon
and select Monitoring enabled, the projector will be added to the
projectors that are being monitored.

Data being updated

) 4

- Network error (Monitor Password authentication error)
\ Xt

No Monitor Password was entered when the projector was
registered, or an incorrect Monitor Password was entered. @ p.11,
p-14, p.15

L Network error (TCP connection error)*2

£A Network error (ESC/VP.net communication error)*3

@ Group name

When projectors are registered to a group, the name of the group that the
projector belongs to is displayed.

@ Display name
Shows the display name.
Power
Shows the power on status for the projector.

@ Power on and normal status @ Power off and normal status

@ Power on and abnormal Power off and abnormal
status status

© Lamp Hours

Shows the lamp operating time for the projector. If the projector has 2
lamps, it shows the lamp operating time for both lamp 1 and lamp 2.

() Temperature level

The following five icons display the differing internal temperature status of
the projector.
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= Internal temperature

normal

=) High-temperature

warning

Internal temperature

€rror

@ Error information

Shows a notification or warning/problem status using the following icons.

&

Uil
21

N EEgEPE @

Clean Air Filter Notice
Replace Lamp (Lamp 1)
Lamp error (Lamp 1)

Lamp failure at power on
(Lamp 1)

High-temperature warning
No Air Filter

Air Flow Sensor Err.

Supply System Error (Ballast
2)

Shutter warning
Other warning

Lamp Error

Lamp Error (Lamp 2)

Lamp failure at power on
(Lamp 1)

High internal temperature
error

Air filter air flow sensor error

mm | Internal temperature

normal

mmmm | High-temperature

g

N ¥

2 & &l g

R

'..)h!'

=

B E

warning

Replace Lamp™
Replace Lamp (Lamp 2)
Lamp error (Lamp 2)

Lamp failure at power on
(Lamp 2)
Replace Air Filter

Low Air Flow

Supply System Error (Ballast
1)

Cinema filter warning

Obstacle Detection warning
Lamp Cover Open

Lamp Error (Lamp 1)
Lamp failure at power on

Lamp failure at power on
(Lamp 2)

Low air flow error

Internal Error

*1

*2

*3
*4

Fan error lﬂ‘ Sensor error

L)
& vy

Supply System Error (Ballast) Supply System Error (Ballast
1)

2)
Shutter error

Cinema filter error
Cooling system error (Peltier Cooling system error (pump)

element)

@ Supply System Error (Ballast Auto Iris Error
@&
(FE
ﬁ

Easy Interactive Function
L Error

Other error

When Temperature level display group view is set to On at Environment setup
in the Tool menu, an icon indicating the internal temperature of the projector
will be displayed on top of the projector icon. The default setting is Off.

T Exhaust vent shutter Error

Obstacle Detection Error

Check the following items.

- Check that the projector's power is turned on.

- Check that the LAN cable is connected.

- Check that Standby Mode is set to Communication On (or Network On) or
Network Monitoring is set to On in the projector's configuration menu.
Check that the projector has been correctly connected to the network.

You can display Replace Lamp at any time preset at Environment setup in the
Tool menu.

~@—_ e The projector information that is generated when a problem is
» ~

detected is stored until EasyMP Monitor is closed. EasyMP Monitor
displays will not be updated automatically even if the projector
status returns to normal. Click "Refresh” in the main window to
update the status.

o Detectable error information differs with the projector you are
using.
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Selecting display items

You can select only the required items to be displayed in Detail list
view.

Procedure

) Select "Option" from the View menu.

—

The Option window will be displayed.

Cption

Display item:

v Group name

[ Projectar name
[ Dizplay name

[ IP address

v Power

v Lamp Haurs

[ Source

[ Temperaturs level
[ Description

v Errar information

ok, Cancel

@5

Select the check box of the item you want to display.

When all of the details of the item cannot be displayed in

Detail list view, drag the boundary line on the right of the item

name so that the view is extended to the desired width.

Sorting lists

You can sort detailed lists by using a specific row as a sort key, such as
projector name order or IP address order.

Procedure

Click the item name of the row you want to use as the sort key.

Searching for desired icons (Projector list)

The Projector list feature is useful for searching in lists when many groups
and projectors are registered and the icon you are looking for is not
displayed on screen.

Procedure

Select "Projector list" from the View menu.
The following window will be displayed.

_..._ Cotvention Hall
@5 Lobby
=] Showroanm
] Showroomn &
Ay Mol
& MoZ
@ Mod
+ @ Showroam B

+# {3 Branch B
(23 Branch C

With Projector list, temperature level icons are not displayed regardless of
the setting of Temperature level display group view at Environment
setup.
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The Projector list lets you check the registration details for groups in a

hierarchical diagram. When you click on an icon, Grouping view and Detail e .-

list view are scrolled so that the selected icon is displayed in the window. ey oo
Lamp schedule noification & O C On [ =] How
Log output & Off  On

- - - ™ Register at startup
Monltorlng using the system tray

™ Change the application lock passward

The projector statuses are always displayed as icons in the system tray, even L |

when Grouping view or Detail list view is not always displayed, and the — |

statuses can be checked by the icon patterns. e ) [

When the configuration menus are set using the following operations, an = =

icon appears in the system tray and the status can be monitored by means
of the icon's pattern.

’ e Right-click the icon in the system tray to open a pop-up menu to
'@‘ select the Open the main screen or Exit.

o If Register at startup in the Environment setup is selected, EasyMP
Monitor starts automatically when the computer's power is turned
on. When using EasyMP Monitor under Windows Vista, Windows
7, or Windows 8, you must have administrator authority in order to
use this function.

(® 2, 1013

The icon patterns are explained below.

@ No problem /i, Problem

Displaying projectors with problem or warning
statuses in a list

Procedure

/ Select "Environment setup” from the Tool menu. You can display a list of only the projectors which have a problem or
The Environment setup window will be displayed. warning status.

@ Select "Resident in the task tray".

Select "Warning and Error Projector list" from the View menu.

The following Warning and Error Projector list window will be displayed.
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If you move the mouse pointer over the icon of the Error information, ;?n; Network error (TCP connection error)*2
details of the error and the remedy will be displayed. If you double-click in = o §
a line, the properties for that projector will be displayed. @ p.27 fg Network error (ESC/VP.net communication error)™

@ Display name

Shows the display name.

el andorp @ Power
pee Shows the power on status for the projector.
. E:;l;;ﬂ Pﬁéﬁ e . @ Power on and normal status @ Power off and normal status
el @ o @ Power on and abnormal Power off and abnormal
status status
@) Lamp Hours
Shows the lamp operating time for the projector.
|| @ Source
L i Shows the input source that has been selected for the projector.

. . . . A Computer or Computerl B Computer2
The icon patterns and their meanings are explained below. WE m@

T B .
@ Type )000( BNC 5 S-Video

Shows the group or projector status.

«a No warnings or problems™! — Video (RCA) ¥ Video (BNC)

SDI E HDBaseT

DVI-D1 or HDMII,
DVI-D, HDMI*4

DVI-D2 or HDMI2*5 D-Video

Warning or problem
An error has occurred on the projector.

e
@ Notification
=

. . . . . DisplayP
The projector requires immediate attention. isplayFort

Monitoring disabled

The projector is not being monitored. If you right-click the icon
and select Monitoring enabled, the projector will be added to the
projectors that are being monitored.

EasyMP I:Ig USB Display

USB or USB1 Em USB2

Data being updated

) 4

Network error (Monitor Password authentication error)

No Monitor Password was entered when the projector was
registered, or an incorrect Monitor Password was entered. @ p.11,
p.14, p.15
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Lamp failure at power on
(Lamp 1)

High internal temperature
error

Lamp failure at power on

(]
=3

Lamp failure at power on

(@ Temperature level = (Lamp 2)

"
.‘.’N

The following five icons display the differing internal temperature status of ‘E Low air flow error Air filter air flow sensor error
the projector.
a1 1 1 E s F
= 1 Internal temperature == ] Internal temperature nternal Error :'JJ an_error
normal normal l!:ﬂ Sensor error Supply System Error (Ballast)
] High-temperature mmmm | High-temperature
warning warning Supply System Error (Ballast @ Supply System Error (Ballast
Internal temperature D) 2)
error Auto Iris Error Cinema filter error
@ Error information . .
() Shutter error Cooling system error (Peltier

Shows a warning/problem status using the following icons. element)

Replace Lamp™6 Replace Lamp (Lamp 1) = ;

8] @ Cooling system error (pump) Exhaust vent shutter Error
Replace Lamp (Lamp 2) ? Lamp error (Lamp 1) fa Easy Interactive Function Obstacle Detection Error
L (Lamp 2) Lamp fail - Eor .
amp error (Lamp amp failure at power on

a (Lamp 1) Other error
Lamp failure at power on @ High-temperature warning *1 When Temperature level display group view is set to On at Environment setup
(Lamp 2) in the Tool menu, an icon indicating the internal temperature of the projector
Replace Air Filter -3 No Air Filter will be displayed on top of the projector icon. The default setting is Off.

*2  Check the following items.
- Check that the projector's power is turned on.
- Check that the LAN cable is connected.
?l)lpp ly System Error (Ballast @ g;lpply System Error (Ballast - Check that Standby Mode is set to Communication On (or Network On) or
Network Monitoring is set to On in the projector's configuration menu.
Cinema filter warning ) Shutter warning *¥3  Check that the projector has been correctly connected to the network.
*4 It describes DVI-D if the projector is equipped with both DVI-D and HDMI
input terminal.

Low Air Flow Air Flow Sensor Err.

3P FEE N 99w

Obstacle Detection warning A Other warning

P Lamp Cover Open Fl Lamp Error *5 It describes HDMI if the projector is equipped with both DVI-D and HDMI
input terminal.
ﬁ Lamp Error (Lamp 1) ﬁ Lamp Error (Lamp 2) *6 You can display Replace Lamp at any time preset at Environment setup in the

Tool menu.
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Detectable error information differs with the projector you are using.

Displaying Projector properties

Right-click on a projector icon in Grouping view or Detail list view and
select Property.

Checking properties in detail

You can check the properties of Group and projectors in detail.

Displaying Group properties

Procedure

You can use either of the following methods to display the
properties.
¢ Displaying the properties for all groups in Grouping view
Right-click in Grouping view and select Property.
¢ Displaying the specified group properties
Right-click an icon in Grouping view and then select Property.

| ol OO BE-BBB 0 S =0 E =B e
“:UJDE D‘SD“;:':'“;';ME,,PEWEIE Lamp Hours Source | Temperature level | Error information

E_ Showroom e N = B

@ CorwentionHe == e e e

@) Looty © 3H B ===

| | |

If you double-click in a line, the properties for that group or projector will
be displayed.

Group hame
Projector name
Digplay name
IP address

Lamp Hours

BEranich &

test]

Labby
10.12.0.224
3H

Temperature level | T——
Description
I Serial Murnber XXX :
“ergion information F1 64001 93057154030
F2 640040 /030
F3 B141wWE100

Ertr information

Mo zignal

@) Shows the projector's serial number. If hyphens are displayed, confirm the serial
number on the label of the projector.

@ Displays the projector firmware version.

Displaying and deleting logs

In your web browser, you can check a transmission log of content such as
what has been controlled by EasyMP Monitor, projector errors. You can
delete logs once you have checked them.

When Log output is set to On at Environment setup in the Tool
menu, transmission logs are stored. The default setting is Off.
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Displaying Log

Procedure

Select "Log" - "View" from the View menu.

The web browser will open and the communication logs up until that time
will be displayed.

Deleting Log

Select "Log" - "Delete" from the View menu. When the confirmation
message is displayed, click "OK".

All logs will be deleted and details of EasyMP Monitor control operations
and details of projector errors from that point onward will be recorded in a
new log.
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Carrying out control using control buttons

Click the icon of a projector to be controlled in Grouping view or Detail
list view, and click a control button to enable control of only that selected
projector.

You can also enable control of all selected projectors by selecting more than
one projector in Grouping view or Detail list view and clicking a control
button. The methods of selecting more than one projector at the same time
are as follow.

o If you select a group icon in Grouping view, all projectors that have
been registered in that group and that are set to be monitored can be
controlled at the same time.

e Hold down the Ctrl key on the keyboard while clicking on the desired
icons.

e Use drag and drop to select a range of desired icons.
uE _OX

Fle Edt View Tool Help

...... Henash Select al (ﬂ) d) % (=] @ ® E = ::%- B = | % Igl)

|

)

Branch B Branch C

Carvantion Lobby

Shaowroom Hal

—
Showroom A Showioom B

The following table shows the meanings of the control buttons.

& Power On Turns the projector power on.
(o) Power Off Turns the projector power off.
— Switch source Switches the input source to the Computerl port
oak) Computer1l or Computer port.
Switch source Switches the input source to the Computer2 port.
oD Computer 2

Switch source Switches the input source to the BNC port.
(-]

BNC

&)

Switch source
Video

Switches the input source to the S-Video port.

Switch source

Switches the input source to the Video port or

o) . .
Video (RCA) video2 port.
ol Switch source Switches the input source to the Videol port.
“ Video (BNC)

Switch source Switches the input source to the SDI port.
@

SDI

Switch source Switches the input source to the HDBaseT port.
i
HEET HDBaseT

Switch source Switches the input source to the DisplayPort
= .

DisplayPort port.

Switch source Switches the input source to the DVI-D1 port or
& | pvi-D, HOMI 1

HDMI1 port.

If the projector is equipped with either DVI-D
port or HDMI port, use this button to switch the
input signal.

If the projector is equipped with both DVI-D
port and HDMI port, use this button to select
DVI-D as an input source.
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Switch source

Switches the input source to the DVI-D2 port or

:"'—_ e Some connected projectors may not be equipped with all of the
'@‘ above ports or functions. If you click a button for a port or function

that is not available, nothing will happen.

e You can select objects to be controlled and use the control buttons
to carry out control operations even when the following are being
displayed.

Group properties @ p.27

Projector properties @ p.27

Warning and Error Projector list

(Control operations can only be carried out for projectors with a
warning status.) @ p.24

& | DVI-D, HDMI 2 | HDMI2 port.
If the projector is equipped with both DVI-D
port and HDMI port, use this button to select
HDMI as an input source.
Switch source D- | Switches the input source to the D4 port.
.
Video
Switch source Switches the input source to EasyMP or
" EasyMP EasyMP.net.
Switch source Switches the input source to USB Display.
= . "
o= USB Display
Switch source Switches the input source to the external
i 1 UsSB1* equipment connected via a USB (Type A) port or
quip yp p
USBI.
Switch source Switches the input source to the external
2| UsB2* equipment connected via a USB2 port.

%

Switch source
LAN*

Switches the input source to the image projected
by the computer via a network.

=

Switch source
Whiteboard

Switches the input source to Whiteboard.

*

If the button does not function, you can switch the input source using the

button.

Carrying out control using a web browser (Web
control)

You can use the computer's web browser to change the configuration menu
settings for projectors.

Procedure

_/ Right-click on the icon of a projector to be controlled in
Grouping view or Detail list view and select "Web control".

The web browser will open and the Web control window will
be displayed.

Web control lets you set the same details as the configuration menu for the
projector. @ Projector's User's Guide
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~@—_ You can select projectors and right-click on them to select Web
27 control even when the following are being displayed. ‘_—
Group properties @ p.27 Erieciors Dete
= E erarcha K 0472009 i
Warning and Error Projector list (Control operations can only be " B Comvention el SOV [ Won | TUE | web | U | P | AT
carried out for projectors with a warning status.) @ p.24 T il N I
@ Mot 12 13 | 14 [ 18 iB 17 iE]
& Noz 19 20 21 22 22 24 25
@:NDS 26 27 28 29 20
= |2, showroom B
@ Mot
@ MNos Timers
c H t t I H t. tt. - Branch B Display name Date Time {24 hour) Operation
arrying out control using tumer settings o [ wanch @ i P T s
v&, Showroom B 4712009 15:45 Pawer ON
. . . . . . @ No3 4/7jz009 18:59 Power ON
This is useful for carrying out certain control operations such as turning a 8. showoom & s e Poer o1
. ' . . S [Conventonbal 4fisioos imes
projector's power on and off at specified times every day or every week.
. . . . . . < \ >
Timer settings can be carried out either for a single projector only, or all at —n e e = —
‘nable isable A Edit [ —
once for all projectors in a group. X X |
| [

Procedure
The details that can be checked and operations that can be carried out at

Select "Timer" - "Timer Settings" from the Tool menu. this time are given below.

The following window will be displayed and you can then check the timer

. Projectors
setting status. o )

Selects a group or projector to check the status of.

When a group is selected, the timer setting statuses for all projectors in that group
are displayed.

@ Date

Shows the current day in a red box.
Days for which timer settings have been made are shown in bold.

Click 4| or » | to switch to the calendar for the previous or next month.
@ Timers

Shows a list of the timer settings.
The line colors in the Timers list have the following meanings:

[ ] Currentday'stimersetting
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When some of the projectors in the group have timer setting
enabled and others have it disabled for the current day's timer
setting

When the current day's timer setting is a disabled setting

11 1

Timer setting for a day other than the current day

@ Delete

Delet Lets you delete timer settings that have been selected from the
timer list.

@ Close
Close Closes the Timer Settings window.

@ Edit

Edi Lets you change the timer settings that have been selected from the
timer list. If a group has been selected for status checking, the
settings cannot be changed.

@ Add

Add Registers new timer settings. @ "Procedures for new timer
settings" p.32

© Enabled/Disabled

Ensbled | Switches the timer settings that have been selected from the timer
list between Enabled and Disabled.

Dizabled

Procedures for new timer settings

Procedure

Click "Add" on the Timer Settings window. The following

window is displayed and the new timer settings are applied.

Schedule mode

Date |2009m4x14 j

Time [24 hour) |19:u4 =l

Dperation |Pc-wer ON j
()4 Cancel

At Operation, you can carry out the operations of turning the power
on and off and switching the input sources, similarly for the control
buttons on the main window. If you set the input source switching,
the projector's power will turn on at the timer start time even if it is
not on at the time. Because of this, it is not necessary to make two
separate timer settings for turning the power on and switching the
input source.

) After completing the timer settings, click "OK".

The timer settings that have been made will be registered and they
can be checked in the displayed timer list.

-
e

~@—_ You can enable and disable all of the timer settings that have been

registered. Select Timer - Enable or Disable from the Tool menu.




Mail notification function settings

The mail notification function can be used to send corresponding
notification messages to a preset e-mail address when a projector that is Mail noficaion unction & bR ~ ai
connected to the network assumes a certain status, or if it experiences a
proble.m or warning. By using this function, the operator can })e not.lfled of TP e P s | S —
a projector’s status or problems even when the operator is in a different
location from the projectors. e e s !
Riecipient mail addiess 1 | Motification ewvent
~¥<- * Up to three addressees (destinations) can be registered and messages . | Sthealon vt
/@\ can be sent to all Of them at once. Recipient mall address 3 | nhatification event
e If a critical problem develops with a projector which causes it to ok Cancel
suddenly stop working, it may not be possible for the projector to
send a message notifying an operator of the problem. Make th ) hil ferri he table bel
o If Standby Mode is set to Communication On (or Network On) or ake the necessary settings while referring to the table below.
Network Monitoring is set to On in the projector configuration Mail notification Set to On to use the mail notification function.
menus, you can monitor the projector even when it is in standby function
mode (when its power is turned off). @ Projector's User's Guide
(w : POw . : ﬂ_ ] ) SMTP server IP ad- | Enter the IP address of the SMTP server. Up to a
e On some projectors, the mail n.otlﬁc.atlon function can be set in the dress maximum of 255 bytes can be entered.
.conﬁguratl(.)n . When potlﬁcatlon messages are set 'Fo be sent When you change a port number of the SMTP server,
in the projector's configuration menu, both the settings in the . . o iy
. . : specify this port number. The default value is "25".
configuration menu and settings made on EasyMP Monitor are i
functional You can enter a valid number from 1 to 65535.
o Detectable status with the mail notification function differs with the Sender mail address | Enter the sender's e-mail address. Up to a maximum
projector you are using. of 255 bytes can be entered.
Recipient mail ad- Specify the destination addresses for the notification
dress 1 e-mail. Up to three destinations can be set. Up to a
Procedure Recipient mail ad- maximum of 255 bytes can be entered.
; dress 2
Select "Mail notification function" from the Tool menu. - .
Recipient mail ad-
dress 3

The Set mail notification function window will be displayed.

Click "Notification event" and check the items for mail
notification in the window that appears.
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Set notification event

[}

Lamp
¥ Replace Lamp
I¥ Lamp failure at power an
v Lamp Cover Open

¥ Lamp Ermor

Air Filter

[V Clean air Filter Notice
¥ Mo air Filter )

¥ Low Air Flow

v Replace A Filer

W' Air Flow Sensar Emr.

IV Air filter air flow sensor error

W' Law air flaw errar

Metwork

I~ Metwark emar (TCP connection enar)

™ Netwark emar (ESCAP net communication emor)

I~ Metwark emor [monitor password authentication error)

|

Click "OK".
The Set mail notification function window appears again.

Repeat steps 3 and 4 to set the notification events to be notified.

3

m—

When the setup is complete, click "OK".

N\

—



An e-mail notifying the operator of a problem/warning/status is issued

If the projector experiences a problem or enters a status requiring attention, Message Remedy
an e-mail like that shown below is sent to the address specified for
Recipient mail address.

Lamp Cover Open Refer to Reading the indicators.
@ Projector's User's Guide

Lamp failure at power
If there is more than one problem, warning, or status, the corresponding on*

messages are output to separate lines.

Lamp Error*

Item Details shown High internal tempera-

E-mail subject [Display name displayed in Grouping view or Detail list ture error
view] Projector status notification

Low air flow error

Body <Display name displayed in Grouping view or Detail list
view> has entered the following status.

Air filter air flow sen-
SOr error

<Warning/error/status message (Please see the table

below)> Obstacle Detection Er-

ror

High-temperature
The details contained in the e-mail message can consist of the following. 8 P

warning
Message Remedy Replace Lamp*
Easy Interactive Func- | Stop using the projector, disconnect the power cable Lamp failure at power
tion Error from the electrical outlet, and contact your local dealer on*

or the nearest address provided in the Support and

Internal E
nternal Brror Service Guide supplied with the projector.

Supply System Error
(Ballast)*

Fan error

Replace Air Filter
No Air Filter

Sensor error

Supply System Error

(Ballast)* Low Air Flow

Auto Iris Error Air Flow Sensor Err.
Cinema filter error Cinema filter warning
Shutter error Shutter warning
Cooling system error Obstacle Detection
(Peltier element) warning

Cooling system error Clean Air Filter Notice
(pump)

Other warning

Exhaust vent shutter
Error

Other error




An e-mail notifying the operator of a problem/warning/status is issued

Message Remedy

No signal No image signals are being received by the projector.
Check the connection status and check that the power
for the connected equipment is turned on.

Network error (TCP Check the following items.

connection error) Check that the projector's power is turned on.
Check that the LAN cable is connected.

Check that Standby Mode is set to Communication On
(or Network On) or Network Monitoring is set to On
in the projector's configuration menu.

@ Projector's User's Guide

Network error Check that the projector has been correctly connected
(ESC/VP.net communi- | to the network. @ Projector's User's Guide
cation error)

Network error (Moni- | Check the projector's Monitor Password.
tor Password authenti-
cation error)

¥ When the projector has 2 lamps, the additional information, such as (Lamp 1)
or (Ballast 1), is displayed after the message so that you can know which lamp
has problems/warnings.

Messages to inform that the projector has recovered from the error or
warning statuses are sent.



Application lock function

You can use the application lock to prevent third parties from operating the / The password entry window will be displayed, so enter the set

projectors using EasyMP Monitor and from changing settings without password and then click "OK".
authority. Opening and closing EasyMP Monitor and status monitoring can

If no password has been set (default setting), click OK without
still be carried out even when the application lock is applied.

entering a password. It is recommended that you enter a password in

In addition, when a password has been set, the password must be entered order to strengthen security.
in order to cancel the application lock. This ensures that the application The application lock will be cancelled and operations can be carried
lock can not be easily cancelled, and thus improves system security. out as normal.

Switching Application lock between Enabled and  Setting a password for cancelling application lock
Disabled

Carry out the following operations while application lock is cancelled.

Enabling the application lock

Select "Application lock" from the Tool menu.

/ Select "Environment setup" from the Tool menu.

The Environment setup window will be displayed.

The application lock will be enabled and no operations will be possible
other than opening and closing EasyMP Monitor and disabling the
application lock.

| Select "Change the application lock password".

| Enter the password in both the "New password" and "New
password (confirm)" boxes and then click "OK".

Disabling the application lock The password can be up to 16 bytes in length. Single-byte

alphanumeric characters can be used.
Procedure

Select "Application unlock" from the Tool menu.
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Troubleshooting

Projectors cannot be monitored or controlled

Cause

Remedy

Cause

Remedy

Is the projector connected to
the network correctly?

Check that the network cable has been connected
correctly. If the cable is not connected correctly,
reconnect it.

Has the projector been set up
correctly for connection to the
network?

Check the settings for the Network configuration
menu command.

@ Projector's User's Guide

Has the projector been set up
correctly for connection to the
network?

Check the settings for the Network configuration
menu command.

@ Projector's User's Guide

Have the SMTP server IP
address, Port Number and
Recipient mail address all been
set correctly?

Check the setting details.

Has EasyMP Monitor been
installed on the computer
correctly?

Uninstall EasyMP Monitor and then re-install it.
@ p3

Are all the projectors that you
want to control or monitor
registered?

Register the projectors. @ p.10

Is the projector's Standby
Mode set to Communication
On (or Network On) or
Network Monitoring set to On
in the configuration menu?

In order to use EasyMP Monitor to monitor and
control the projector when it is in standby mode, the
projector's Standby Mode must be set to
Communication On (or Network On) or Network
Monitoring must be set to On in the configuration
menu.

@ Projector's User's Guide

Is the projector's Standby
Mode set to Communication
On (or Network On) or
Network Monitoring set to On
in the configuration menu?

In order to use EasyMP Monitor to monitor and
control the projector when it is in standby mode, the
projector's Standby Mode must be set to
Communication On (or Network On) or Network
Monitoring must be set to On in the configuration
menu.

@ Projector's User's Guide

Has a critical problem
developed causing the
projector to momentarily stop
working?

When the projector has momentarily stopped
working, it cannot send e-mail messages. If the
projector cannot be reset even after it has been
checked, contact your dealer or the nearest address
provided in the Support and Service Guide supplied
with the projector.

An e-mail message is not sent when a problem
occurs with a projector

Is power being supplied to the
projector?

Check if the power supply to the location where the
projector is set up has been interrupted, or if the
circuit breaker for the electrical outlet that the
projector is connected to has been tripped.

Cause

Remedy

Is the projector connected to
the network correctly?

Check that the network cable has been connected
correctly. If the cable is not connected correctly,
reconnect it.




Uninstalling EasyMP Monitor

To save or transfer the existing projector settings, make a copy of the EMP
Monitor.dat file before you uninstall the software. @ "Transferring the
settings" p.7

The following procedures to uninstall EasyMP Monitor vary depending on
your operating system.

e If your operating system is Windows 2000 or Windows XP
Click "Start" - ("Settings") - "Control Panel" - "Add/Remove Programs" or
"Add or Remove Programs" to uninstall EasyMP Monitor.

e If your operating system is Windows Vista or Windows 7

Click "Start" - "Control Panel" - "Uninstall a program" to uninstall
EasyMP Monitor.

o If your operating system is Windows 8
Select "Charms" - "Search”, and then right-click (press and hold) "EasyMP
Monitor Ver.X.XX". Select "Uninstall" from the app bar to uninstall
EasyMP Monitor.

~- Under Windows Vista, Windows 7, and Windows 8, settings and logs
@ remain on the hard disk even after EasyMP Monitor is uninstalled. If
you do not need this information, delete the EasyMP Monitor
Ver.X.XX (Ver.X.XX represents the version of the existing software)
folder. This folder can be found at "C:\Users\(User Name)\AppData
\Local\VirtualStore\Program Files\EPSON Projector" if the default
settings were used to install the software.




General Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval ©SEIKO EPSON CORPORATION 2013. All rights reserved.
system, or transmitted in any form or by any means, electronic, mechanical,

photocopying, recording, or otherwise, without the prior written permission of Seiko

Epson Corporation. No patent liability is assumed with respect to the use of the

information contained herein. Neither is any liability assumed for damages resulting

from the use of the information contained herein.
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Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this
product or third parties for damages, losses, costs, or expenses incurred by the
purchaser or third parties as a result of: accident, misuse, or abuse of this product or
unauthorized modifications, repairs, or alterations to this product, or (excluding the
U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.

Seiko Epson Corporation shall not be liable against any damages or problems arising
from the use of any options or any consumable products other than those designated as
Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

The contents of this guide may be changed or updated without further notice.

Mlustrations in this guide and the actual projector may differ.

Trademarks

Microsoft, Windows, Windows Vista, and the Windows logo are trademarks
of Microsoft Corporation in the United States of America and other
countries.

Macintosh is a registered trademark of Apple Computer, Inc.

Pentium is a registered trademark of Intel Corporation.

EasyMP and EasyMP.net are trademarks of Seiko Epson Corporation.
Other product names used herein are also for identification purposes only
and may be trademarks of their respective owners. Epson disclaims any and
all rights in those marks.
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